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Copyright © 2019, Oracle. All rights reserved. 


The Programs (which include both the software and documentation) contain proprietary information; they are 
provided under a license agreement containing restrictions on use and disclosure and are also protected by 
copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or 
decompilation of the Programs, except to the extent required to obtain interoperability with other 
independently created software or as specified by law, is prohibited. 


The information contained in this document is subject to change without notice. If you find any problems in 
the documentation, please report them to us in writing. This document is not warranted to be error-free. 
Except as may be expressly permitted in your license agreement for these Programs, no part of these 
Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any 
purpose. 


If the Programs are delivered to the United States Government or anyone licensing or using the Programs 
on behalf of the United States Government, the following notice is applicable: 


U.S. GOVERNMENT RIGHTS  
Programs, software, databases, and related documentation and technical data delivered to U.S. 
Government customers are “commercial computer software” or “commercial technical data” pursuant to the 
applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, 
duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical 
data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, 
to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--
Restricted Rights (June 1987). Oracle Corporation, 500 Oracle Parkway, Redwood City, CA 94065. 


The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently 
dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, 
redundancy and other measures to ensure the safe use of such applications if the Programs are used for 
such purposes, and we disclaim liability for any damages caused by such use of the Programs. 


The Programs may provide links to Web sites and access to content, products, and services from third 
parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. 
You bear all risks associated with the use of such content. If you choose to purchase any products or 
services from a third party, the relationship is directly between you and the third party. Oracle is not 
responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the 
agreement with the third party, including delivery of products or services and warranty obligations related to 
purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may 
incur from dealing with any third party. 


Oracle, JD Edwards, and PeopleSoft are registered trademarks of Oracle Corporation and/or its affiliates. 
Other names may be trademarks of their respective owners. 


Open Source Disclosure 


Oracle takes no responsibility for its use or distribution of any open source or shareware software or 
documentation and disclaims any and all liability or damages resulting from use of said software or 
documentation. The following open source software may be used in Oracle’s PeopleSoft products and the 
following disclaimers are provided. 


Apache Software Foundation 


This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/). Copyright 1999-2000. The Apache Software Foundation. All rights reserved.  
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THIS SOFTWARE IS PROVIDED “AS IS'” AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE 
SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 


OpenSSL 


Copyright 1998-2003 The OpenSSL Project. All rights reserved.  


This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit 
(http://www.openssl.org/). 


THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, 
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE. 


SSLeay 


Copyright (C) 1995-1998 Eric Young. All rights reserved. 


This product includes cryptographic software written by Eric Young  (eay@cryptsoft.com). This product 
includes software written by Tim Hudson (tjh@cryptsoft.com). Copyright (C) 1995-1998 Eric Young. All 
rights reserved. THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 


Loki Library 


Copyright 2001 by Andrei Alexandrescu. This code accompanies the book: Alexandrescu, Andrei. 
“Modern C++ Design: Generic Programming and Design Patterns Applied”. Copyright (c) 2001. 
Addison-Wesley. Permission to use, copy, modify, distribute and sell this software for any purpose is 
hereby granted without fee, provided that the above copyright notice appear in all copies and that both 
that copyright notice and this permission notice appear in supporting documentation 
 


Helma Project 
 



mailto:tjh@cryptsoft.com
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Copyright 1999-2004 Helma Project. All rights reserved. THIS SOFTWARE IS PROVIDED “AS IS” AND 
ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE HELMA PROJECT OR ITS CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 


 
Helma includes third party software released under different specific license terms. See the licenses 
directory in the Helma distribution for a list of these license. 


 
Sarissa 
 


Copyright 2004 Manos Batsis 
 


This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser 
General Public License as published by the Free Software Foundation; either version 2.1 of the 
License, or (at your option) any later version. 


 
This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without 
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See 
the GNU Lesser General Public License for more details. 


 
You should have received a copy of the GNU Lesser General Public License along with this library; if 
not, write to the Free Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA  02111-1307 
USA. 
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Updates for CS 9.0 Bundle #54, Regulatory 
Release 1 2020-2021 
Note. This PDF package is an update to the PeopleSoft Financial Aid 9.2 PeopleBook and other 
related Campus Solutions PeopleBooks as noted. It describes CS 9.0 Patch ID # 29757777 / 
Product Update ID # 945173 that was posted to My Oracle Support in July 2019. Use this PDF 
package in conjunction with your PeopleBook to maintain a complete set of documentation. 


Documentation about bundle changes is incorporated into the relevant 9.2 PeopleBook chapters. 


PDFs of the updated 9.2 chapters that contain the 9.0 bundle changes are attached. 


Use this Overview document to view a list of the bundle changes and updated chapters. 


Using PDF Package (PDF Portfolio) Documentation 
These instructions are for Adobe Reader DC with the latest updates installed (In Adobe Reader, 
click Help, Check for Updates).  
To view the list of chapters, click View > Portfolio > Details. 
To search for documentation about the changes within a particular chapter, open the chapter and 
press CTRL + F. Enter “bundle xx” where xx is the bundle number and click Next. 
To search the entire package for documentation updates, click Edit > Search Entire Portfolio. 


 
Note! Cross references in PDF chapters appear as follows: 
  
• If a cross reference is to a topic in the same book (for example, Campus Community topic A 


contains a cross reference to Campus Community topic B), the cross reference displays only 
the topic title.  


 
• If a cross reference is to a topic in a different book, the cross reference displays the topic title 


and the book name.  
 
• Some cross references appear as links but are actually text-only.  
 


Here is a list of the Bundle 54 changes and the chapters that contain documentation about those 
changes. Chapters are in the PeopleSoft Financial Aid 9.2 PeopleBook unless noted otherwise: 


• Updated pages to accommodate managing PROFILE for Aid Year 2020-2021. Changes 
made by College Board to the data provided in their XML files are accommodated on the 
PROFILE related records. 


 
o Processing and Using Institutional Financial Aid Applications.pdf 


Updates Not in Documentation 
These updates did not require updates to PeopleBooks or Online Help: 


• Updated FISAP for 2020-2021. 
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• Updated INAS for 2020-2021. 





		Apache Software Foundation

		OpenSSL

		SSLeay

		Updates for CS 9.0 Bundle #54, Regulatory Release 1 2020-2021

		Updates Not in Documentation






Chapter _


Processing and Using Institutional
Financial Aid Applications


Maintaining Institutional Financial Aid Applications


Your institution can gather additional resource information about students and their families by using the
College Board PROFILE application which is electronically supported by the System or by entering your
institutional application on the pages in this component.


Note: The College Board PROFILE and institutional application data share the same pages. You might
unintentionally create multiple institutional aid records for a student from these three sources, which
could cause unintended INAS calculation results.


Note: Question marks or blanks on College Board PROFILE data files are converted or appear as zeros in
currency based numeric fields.


For further information about the fields in this component, please refer to the College Board's Financial
Aid Services Information Center (https://groups.collegeboard.org/fas) for supporting documentation.


This section lists common elements and discusses how to:


• Review student information.


• Review custodial parent information.


• Review non custodial parent information.


• Review currency information, family information, and institutional questions.


• Review all computed data for student and parents.


Related Links
Loading and Managing PROFILE Records
Using INAS Batch Calculations


Common Elements Used in This Section
 Need Summary Click this link to access the Need Summary page, where


you can review the student's federal and institutional need
calculations.


 FM  (federal methodology) Click this link to access the INAS Fed Extension page, where
you can override INAS Local Policy Options for federal data.


Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 1
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 IM  (institutional methodology) Click this link to access the Institutional Need Calculation
Extension 1 page, where you can override INAS Local Policy
Options for institutional data.


 INAS  (institutional need analysis
system)


Click this button to calculate an unofficial federal and
institutional Expected Family Contribution (EFC) by using the
College Board's Institutional Need Analysis System (INAS). A
COBOL program is used to perform the INAS calculation.


INAS NCP (institutional need analysis
system non custodial parent button)


Click this button to calculate the non custodial parent
contribution.


Note: Calculate the non-custodial parent contribution before
invoking the regular INAS calculation.
Calculating a non custodial parent contribution creates an
INAS Extension record, selects the Use Non-Custodial Parent
Contribution check box and populates the PC From Non-
Custodial Parent (parent contribution from non-custodial
parent) field in INAS Extension 5. After this, when the
regular INAS calculation is invoked, the non-custodial parent
contribution is added to the Custodial Parent contribution and
overall expected family contribution.


The system displays the student's name, ID, HouseHold Type (HHA for Custodial Parent, HHB for Non
Custodial Parent, HHA/HHB for both Custodial and Non Custodial Parent), institution, dependency
status, application source, and aid year at the top of each review page. These two terms also appear at the
top of each review page:


HouseHold Type (household type) Displays the type of PROFILE application received:


• HHA/HHB – both custodial parent and non custodial parent
applications received.


• HHA – only custodial parent application received.


• HHB – only non custodial parent application received.


HHB Indicated (non custodial
parent PROFILE application received
indicator)


Displays whether or not a non custodial parent PROFILE
application is indicated or can exist for a custodial parent
household.


• Yes – non custodial parent PROFILE application is indicated
or can exist for a custodial parent household.


• No – non custodial parent PROFILE application not
indicated or cannot exist for a custodial parent household.


Related Links
Defining Federal and Institutional Methodologies
Overriding Expected Family Contribution (EFC)
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Pages Used for Institutional Applications


Note: The navigation paths for the pages listed in the following page introduction table are for aid year
20nn-20nn. Oracle supports access for three active aid years with valid INAS calculations. Earlier aid
year institutional application data is available for display only at Financial Aid > Financial Aid History >
View Archived Application Data > Institutional Application.


Page Name Definition Name Navigation Usage


Student Data INST_STUDENT_nn Financial Aid > Institutional
Application Data > Maintain
Application 20nn-20nn >
Student Data


View or enter student
information.


Custodial Parent Data INST_PARENT_nn Financial Aid > Institutional
Application Data > Maintain
Application 20nn-20nn >
Custodial Parent Data


View or enter custodial parent
information.


Non Custodial Parent Data INST_NCPARENT_nn Financial Aid > Institutional
Application Data > Maintain
Application 20nn-20nn >
Non Custodial Parent Data


View or enter non custodial
parent information.


Miscellaneous Data INST_MISC_nn Financial Aid > Institutional
Application Data > Maintain
Application 20nn-20nn >
Miscellaneous Data


View or enter signature,
 family member, school
selection, and institutional
question (the College Board
PROFILE Section Q)
information. You can also
view FNAR messages on this
page.


Computation Summary INST_COMP_SUMM_nn Financial Aid > Institutional
Application Data > Maintain
Application 20nn-20nn >
Computation Summary


View or enter computed
parent and student income,
 allowance, and asset
information using your
institutional and federal
methodology. The computed
values appear here.


Reviewing Student Information
Access the Student Data page (Financial Aid > Institutional Application Data > Maintain Application
20nn-20nn > Student Data).


Bundle 54


New image: Updates for Borrower Information
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Image: Maintain Institutional Application, Student Data tab (page 1 of 5)


This example illustrates the fields and controls on the Maintain Institutional Application, Student Data tab
(page 1 of 5). You can find definitions for the fields and controls later on this page.


Image: Maintain Institutional Application, Student Data tab (page 2 of 5)


This example illustrates the fields and controls on the Maintain Institutional Application, Student Data tab
(page 2 of 5). You can find definitions for the fields and controls later on this page.


Image: Maintain Institutional Application, Student Data tab (page 3 of 5)


This example illustrates the fields and controls on the Maintain Institutional Application, Student Data tab
(page 3 of 5). You can find definitions for the fields and controls later on this page.
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Bundle 54


New image: Updates for Borrower Information


Image: Maintain Institutional Application, Student Data tab (page 4 of 5)


This example illustrates the fields and controls on the Maintain Institutional Application, Student Data tab
(page 4 of 5). You can find definitions for the fields and controls later on this page.


Image: Maintain Institutional Application, Student Data tab (page 5 of 5)


This example illustrates the fields and controls on the Maintain Institutional Application, Student Data tab
(page 5 of 5). You can find definitions for the fields and controls later on this page.


Bio/Demo and Citizenship Data
The data for the fields in this group box are populated from Campus Community Bio/Demo data.


 National ID Displays the student's National ID.


Note: If the PROFILE Application type = 4 (International
PROFILE) and the National ID is blank, the student is loaded
into PROFILE Staging with XXX-XX-XXXX. This permits
Search/Match to take place and potentially load the student into
the Institutional Application tables with the NID rendered as
XXX-XX-XXXX.
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Reported Country Displays the student's reported country if not United States of
America.


Bio/Demo Citizenship Status Click this link to access the Campus Community Citizenship/
Passport page to confirm the citizenship status of the student's
Biographic/ Demographic data against the values in the
Reported Country and Reported Status fields.


CSS Data
 CSS ID (college scholarship service
ID)


Note: CSS ID was the identifier assigned by College Board
to ensure both privacy and quick retrieval of records. CSS ID
was removed from PROFILE XML files by College Board
effective Aid Year 2019-2020. It will not be displayed for Aid
Year 2019-2020 forward.


CB FinAid ID (College Board
Financial Aid ID)


Displays a unique lifetime ID assigned to the student's record by
the PROFILE system to ensure both privacy and quick retrieval
of records. When you call the College Board inquiry number
with questions about specific records, it is helpful to know the
student's College Board Financial Aid ID number.


Application Type Displays:


• 1 if the application is a Domestic PROFILE.


• 2 if the application is a Canadian PROFILE.


• 3 if the application is an International PROFILE.


Fee Payment Code Indicator Indicates if the student used a Fee Payment Code for the
institution.


Bundle 54


New field: Updates for Borrower Information


Name of School Name of the student's current school.


Bundle 54


New field: Updates for Borrower Information


Student's Information
 Financial Aid Status Enter the student's status as it relates to receiving financial aid.


 Marital Status Code Select the marital status to be used for financial aid purposes.
 This marital status can differ from the Bio/Demo Data page
marital status.
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Student IM Zip (student institutional
methodology zip code)


The student zip code used for cost of living adjustment
calculations. Typically matches the student permanent zip code
but can be updated independently of student permanent zip code
if needed.


Parent IM Zip (parent institutional
methodology zip code)


The parent zip code used for cost of living adjustment
calculations. Typically matches the parent permanent zip code
but can be updated independently of parent permanent zip code
if needed.


Student's Income/Benefits/Resources – Base (Prior Prior Year)
These fields are items from the United States federal income tax forms or data gathered from other
applicable sources such as an institutional application or a third party source.


Student's Income/Benefits/Resources – Base+2 (Anticipated Year)
Receive Tuition Benefits Indicate whether or not the student receives tuition benefits from


the parents' employers.


Agencies/Foundation Support Indicate whether the student expects to receive from agencies or
foundations to pay for educational expenses during any year of
attendance.


Government Support Indicate whether the student expects to receive from her
government to pay for educational expenses during any year of
attendance.


Student's Assets – Current
 Price Enter purchase price of the student's home.


Student's Expenses – Base (Prior Prior Year)
Child Support Paid Enter the child support paid by the student.


Medical/Dental Enter the medical and/or dental out of pocket expenses paid by
the student.


Veterans Benefits Enter the monthly amount of VA Benefits received by the
student.


Months Enter the number of months the veterans benefits were received
in the calendar year.


Currency Information
 Currency Code Enter the currency in which the original data was reported by


the student.
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Currency Rate Enter the currency conversion rate used to process the student's
data.


Parent Country Co-Efficient Enter the country coefficient used to process the parents’
financial data.


Converted Currency Code Enter the original currency converted into US dollars reported
by citizens living abroad and Canadians.


Converted Currency Rate Enter the rate the student used in converting their currency into
US dollars. Reported by citizens living abroad and Canadians.


Student Country Co-Efficient Enter the country coefficient used to process the student’s
financial data.


Non-Custodial Student Data
These fields display student information as reported on the Non-Custodial PROFILE.


Reviewing Custodial Parent Information
Access the Custodial Parent Data page (Financial Aid > Institutional Application Data > Maintain
Application 20nn-20nn > Custodial Parent Data).


Image: Maintain Institutional Application, Custodial Parent Data tab (page 1 of 6)


This example illustrates the fields and controls on the Maintain Institutional Application, Custodial Parent
Data tab (page 1 of 6). You can find definitions for the fields and controls later on this page.


Bundle 54


New image: Updates for Borrower Information
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Image: Maintain Institutional Application, Custodial Parent Data tab (page 2 of 6)


This example illustrates the fields and controls on the Maintain Institutional Application, Custodial Parent
Data tab (page 2 of 6). You can find definitions for the fields and controls later on this page.


Image: Maintain Institutional Application, Custodial Parent Data tab (page 3 of 6)


This example illustrates the fields and controls on the Maintain Institutional Application, Custodial Parent
Data tab (page 3 of 6). You can find definitions for the fields and controls later on this page.
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Image: Maintain Institutional Application, Custodial Parent Data tab (page 4 of 6)


This example illustrates the fields and controls on the Maintain Institutional Application, Custodial Parent
Data tab (page 4 of 6). You can find definitions for the fields and controls later on this page.


Bundle 54


New image: Updates for Borrower Information


Image: Maintain Institutional Application, Custodial Parent Data tab (page 5 of 6)


This example illustrates the fields and controls on the Maintain Institutional Application, Custodial Parent
Data tab (page 5 of 6). You can find definitions for the fields and controls later on this page.
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Image: Maintain Institutional Application, Custodial Parent Data tab (page 6 of 6)


This example illustrates the fields and controls on the Maintain Institutional Application, Custodial Parent
Data tab (page 6 of 6). You can find definitions for the fields and controls later on this page.


Parents Grid
This section of the page displays parental information including relationship to student as reported on the
PROFILE.


Parent's Income and Benefits – Base (Prior Prior Year)
These fields are items from the United States federal income tax forms or data gathered from other
applicable sources such as an institutional application or a third party source.


Child Support Received Enter the child support received by the parents for their
dependent children.


Child Support Received Student Enter the amount of child support the custodial household
received from the non-custodial household for the applicant.


Parent's Income and Benefits – Base+1 (Recent Year)
These fields are items from the United States federal income tax forms or data gathered from other
applicable sources such as an institutional application or a third party source.


Parent's Income and Benefits – Base+2 (Anticipated Year)
These fields are items from the United States federal income tax forms or data gathered from other
applicable sources such as an institutional application or a third party source.


Non-Custodial Parent Contribution The amount the non-custodial parent has offered to pay for the
student's educational expenses.


Parent's Assets – Current
Owed to Parent by Others Enter the amount owed to parents by others


Annual Debt Income The annual income realized by the parents from debts owed to
them.


Copyright © 2019, Oracle and/or its affiliates. All rights reserved. 11
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Value of Other Assets Enter the value of any assets not already reported.


Price Enter purchase price of the parents' home.


 Real Estate Purchase Year Enter purchase year of any other real estate.


 Price Enter purchase price of any other real estate.


Parents' Expenses – Base (Prior Prior Year)
Enter the parents' expenses from the Base Year for these fields.


Other Expenses Enter the cost of any parental expenses not reported anywhere
else on the PROFILE.


Parents' Expenses – Base+1 (Recent Year)
Enter the parents' expenses from the Recent Year for these fields.


Academic Year
 Other Tuition Paid The amount of private elementary/secondary tuition expected to


be paid by the parents during the academic year.


 Number of Tuition Paid The number of children for which private elementary/secondary
tuition is expected to be paid by the parents during the academic
year.


Parents' Information
Parent Type 1 and Parent Type 2 Select the type of parent providing information on the


PROFILE. Values include: Father, Legal Guardian, Mother,
Other, Step Father, Step Mother.


Computed Age 1 and Computed Age
2


Indicates the calculated age for the parent.


Biological Adoptive Parent Identifies a dependent student's custodial parent when the
biological/adoptive parents are separated, divorced, or were
never married. Values include: Parent 1 and Parent 2.


Veteran Indicator 1 and Veteran
Indicator 2


Indicates the veteran status of parents.


Bundle 54


New field: Updates for Borrower Information
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Currency Information
 Currency Code Enter the currency in which the original data was reported by


the student.


Currency Rate Enter the currency conversion rate used to process the student's
data.


Country Coefficient Enter the country coefficient used to process the student's data.


Converted Currency Code Enter the original currency converted into US dollars reported
by citizens living abroad and Canadians.


Converted Currency Rate Enter the rate the student used in converting their currency into
US dollars. Reported by citizens living abroad and Canadians.


Explanation / Certification
PROFILE applicants can indicate on their applications a variety of Special Circumstances that may affect
the calculation of financial need. These include:


• Change in Employment


• Scholarships


• Medical/Dental Expenses


• Siblings Private School


• Catastrophic Event


• Elder Care


• Non-Recurring Income


• Financial Support


PROFILE applicants can also indicate if they have no Special Circumstances or Special Circumstances
not listed in the PROFILE application.


Explanations Text Displays the actual explanations and special circumstances text
provided by the filer.


Reviewing Non Custodial Parent Information
Access the Non Custodial Parent Data page (Financial Aid > Institutional Application Data > Maintain
Application 20nn-20nn > Non Custodial Parent Data).
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Image: Maintain Institutional Application, Non Custodial Parent Data tab


This example illustrates the fields and controls on the Maintain Institutional Application, Non Custodial
Parent Data tab. You can find definitions for the fields and controls later on this page.


Please refer to the “Reviewing Custodial Parent Information” section of this topic for similar field
descriptions. Notable exceptions are in this section.


IM NCP (institutional methodology
non custodial parent link)


Click this link to view the INAS Institutional NCP Ext 1 page
from where you can navigate further to the INAS Institutional
NCP Ext 2 and INAS Institutional NCP Ext 3 pages. Use
these pages to provide more information for the system to
calculate non-custodial parent contribution using Institutional
Methodology. For descriptions of the fields in these pages, refer
to the similar fields described in Using FM and IM Extensions
to Override Options.


INAS NCP (institutional need analysis
system non custodial parent button)


Click this button to calculate the Institutional Methodology non
custodial parent contribution.


Note: Calculate the non-custodial parent contribution before
invoking the regular INAS calculation.
Calculating a non custodial parent contribution creates an
INAS Extension record, selects the Use Non-Custodial Parent
Contribution check box and populates the PC From Non-
Custodial Parent (parent contribution from non-custodial
parent) field in INAS Extension 5. After this, when the
regular INAS calculation is invoked, the non-custodial parent
contribution is added to the Custodial Parent contribution and
overall expected family contribution.


See the Common Elements Used in This Section and the
Reviewing All Computed Data for Student and Parents sections
for detailed information.


14  Copyright © 2019, Oracle and/or its affiliates. All rights reserved.







Chapter _ Processing and Using Institutional Financial Aid Applications


Reviewing Processing Messages and Institutional Questions
Access the Miscellaneous Data page (Financial Aid > Institutional Application Data > Maintain
Application 20nn-20nn > Miscellaneous Data).


Image: Maintain Institutional Application, Miscellaneous Data tab


This example illustrates the fields and controls on the Maintain Institutional Application, Miscellaneous
Data tab. You can find definitions for the fields and controls later on this page.


FNAR Messages
The system displays the Financial Need Analysis Report (FNAR) message number, message text,
and message Values 1 through 5, if any. These College Board PROFILE messages inform you about
processing exceptions to data received and assumptions that should be taken into consideration when
reviewing the institutional application. This information is displayed for the Custodial and Non-custodial
Parents, as it is provided by PROFILE.


Assumption Messages
The system displays the CSS INAS IM Assumptions alphanumeric code, message text, and value, if any.
These are the INAS Assumptions triggered during the need analysis methodology and include the full text
of the e-FNAR assumption generated by the PROFILE system and any corresponding values.


Institutional Questions
 Number Number of an application question that the student/family


believes warrants further explanation. This number may also
refer to a series of additional questions that have been modified
for the institution by College Board PROFILE.


 Answer Answer to the question shown in the Number field.
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Reviewing All Computed Data for Student and Parents
Access the Computation Summary page (Financial Aid > Institutional Application Data > Maintain
Application 20nn-20nn > Computation Summary).


Image: Maintain Institutional Application, Computation Summary tab (page 1 of 4)


This example illustrates the fields and controls on the Maintain Institutional Application, Computation
Summary tab (page 1 of 4). You can find definitions for the fields and controls later on this page.
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Image: Maintain Institutional Application, Computation Summary tab (page 2 of 4)


This example illustrates the fields and controls on the Maintain Institutional Application, Computation
Summary tab (page 2 of 4). You can find definitions for the fields and controls later on this page.


Image: Maintain Institutional Application, Computation Summary tab (page 3 of 4)


This example illustrates the fields and controls on the Maintain Institutional Application, Computation
Summary tab (page 3 of 4). You can find definitions for the fields and controls later on this page.
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Image: Maintain Institutional Application, Computation Summary tab (page 4 of 4)


This example illustrates the fields and controls on the Maintain Institutional Application, Computation
Summary tab (page 4 of 4). You can find definitions for the fields and controls later on this page.


This page is designed to display computed need analysis results based on both the parent's and student's
information. Therefore, the page displays a Parent Contribution Section and a Student Contribution
Section. The following sections describe what each column represents.


Note: Computation tables display no intermediate values until the INAS calculation is called using batch
or online calculation.


Note: To more closely align interim calculation results with the Estimated Federal Methodology (EFM)
computation worksheets from the College Board, the Computation Summary page displays an N/A
value for several fields. For parents of dependent students and independent students with dependents,
EFM calculations display N/A for From Income, From Assets, Total Contribution - Income and Total
Contribution - Assets fields.


Contribution Summary
The PARENT CONTRIBUTION section displays three columns: IM Base, IM w/Options, and EFM.


• The IM Base column displays standard base INAS calculations. Although the IM Base calculation is
not delivered as part of the PROFILE record, Oracle supports calculating the College Board's IM Base
calculation if INAS is invoked after the initial load of the PROFILE record.


• The IM w/Options column is the result of using the institutional options that you set up when you
defined your institutional methodology. IM w/Options is delivered as part of the PROFILE record.


• The EFM column displays the estimated federal methodology amount. Financial aid administrators
are reminded that the EFM is always estimated and never official.


The STUDENT CONTRIBUTION section displays three columns: IM Base,  IM w/ Options,  and EFM.


• The IM Base column displays standard base INAS calculations. Although the IM Base calculation is
not delivered as part of the PROFILE record, Oracle supports calculating the College Board's IM Base
calculation if INAS is invoked after the initial load of the PROFILE record.
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• The IM w/Options column is the result of using the institutional options that you set up when you
defined your institutional methodology. IM w/Options is delivered as part of the PROFILE record.


• The EFM column displays the estimated federal methodology amount. Financial aid administrators
are reminded that the EFM is always estimated and never official.


 Total Income Indicates the custodial parent's total contribution for the student
from the base IM computation.


Custodial Parent Information
The system displays the calculations for Total Income, Total Contribution, Number in College
Adjustment, Contribution for Student, contribution From Income, and contribution From Assets for
Parent's Contribution and Student's Contribution.


For the PARENT CONTRIBUTION IM Base:


 Percent Income Indicates the custodial parent's percentage of total parents
income from the base IM computation.


 Contribution From Income Indicates the custodial parent's contribution from income for the
student from the base IM computation.


 Contribution From Assets Indicates the custodial parent's contribution from assets for the
student from the base IM computation.


For the PARENT CONTRIBUTION IM w/Options


 Percent Income Indicates the custodial parent's percentage of total parental
income from the option IM computation.


 Contribution From Income Indicates the custodial parent's contribution from income for the
student from the option IM computation.


 Contribution From Assets Indicates the custodial parent's contribution from assets for the
student from the options IM computation.


Education Savings Calculations
The system displays the Parent's and the Student's Annual Education Savings Allowance (AESA) and
Cumulative Education Savings Allowance (CESA) calculations. These are PROFILE specific calculated
values used in INAS calculations for Institutional Methodology.


Income
The system displays the calculations for Taxable Income, Untaxed Income, Adjustments to Income, and
Total Income for Parent's Contribution and Student's Contribution.


Allowances
The system displays the calculations for U.S. Income Tax, FICA Taxes, Medical/Dental, Elementary/
Secondary Tuition, Employment Allowance, Annual Education Savings, Income Protection Allowance/
MMA, Total Allowances, Calculated Available Income, and Available Income for Parent's Contribution
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and Student's Contribution. The Total Contribution - Income amount is the sum of all the fields in the
Allowances section.


Assets
The system displays the calculations for Cash Savings, IRA Value, Home Equity, Real Estate/Investment
Equity, Adjusted Business/Farm Value, Sibling's Assets/Prepaid Tuition, Value of Trusts, and Net Worth
for Parent's Contribution and Student's Contribution.


The system displays the calculations for Emergency Reserve Allowance, Cumulative Education Savings,
Low Income Asset Allowance, Discretionary Net Worth, Asset Protection Allowance, Conversion
Percentage, and Income Supplement for Parent's Contribution and Student's Contribution. The Total
Contribution - Assets amount is the sum of all the fields in the Assets section.


Non Custodial Parent Computation Summary Data
Education Saving Calculation Displays the non-custodial parents’ Annual Education Savings


Allowance (AESA) and Cumulative Education Savings
Allowance (CESA) calculations. These are PROFILE specific
calculated values used in INAS calculations for Institutional
Methodology.


IM Options Non–Custodial
Parents Contribution (institutional
methodology options non custodial
parents contribution)


Displays a logical grouping for the Non-Custodial Parent
Contribution results under the IM options computation.


Non Custodial Parent Base
Adjustment


Displays a logical grouping for the data elements for the
biological/adoptive parent base computation results.


Non-Custodial Parent Contribution
Summary


Click this link to view the Institutional NCP Cont Summary 
(institutional non custodial parent contribution summary) page
displaying calculations for non-custodial parents’ contribution.
 For descriptions of the fields in the Non-Custodial Parent
Contribution Summary, refer to the similar fields already
described in this Computation Summary sub-topic.


Loading and Managing PROFILE Records


Before you begin loading applications, define all PROFILE data load parameters and set up your run
control options using the Financial Aid Run Controls page. This section discusses how to:


• Load PROFILE records.


• View PROFILE load summaries.


• Manage suspended PROFILE records.


• Delete PROFILE records.
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Note: Oracle supports the CSS / Financial Aid PROFILE File Layout (with corresponding school year)
for PROFILE data received from the College Board.


Pages Used to Load and Manage PROFILE Records


Note: Oracle supports two academic years of PROFILE data loads.


Page Name Definition Name Navigation Usage


Load Records SFA_PF_RUNCNTL Financial Aid > File
Management > PROFILE
Import > Load Records >
Load Records


Import PROFILE records into
the database.


Load Summary SFA_PF_IN_LOAD Financial Aid > File
Management > PROFILE
Import > Load Summary >
Load Summary


From the PROFILE Staging
Table, view the load status
and other details of each
record of a PROFILE load
instance.


Suspense Management SFA_PF_SUSP_CNTRL Financial Aid > File
Management > PROFILE
Import > Suspense
Management > Suspense
Management


Process suspended or skipped
PROFILE records.


Loading PROFILE Applications
Every time the PROFILE Load process is run, all records are inserted into the PROFILE Staging
tables. Depending on your Search/Match, Add Level, and Suspense Level Rules, the student's record is
inserted into either the Institutional Application (IM) tables or managed through the PROFILE Suspense
Management component. As an example, your school may only admit 60 percent of those students who
actually list your School Code on the PROFILE application. Instead of loading every student who has
listed your school code on the PROFILE application, you can load only those students officially admitted.


Access the Profile Load page (Financial Aid > File Management > PROFILE Import > Load Records >
Load Records).


Load Option Select the Load Option.


• Load Only — Select this option to only load the specified
PROFILE files. No suspended or skipped records are
reevaluated for loading.


• Recycle Only — Select this option to only reevaluate
suspended PROFILE records for loading.


• Load and Recycle — Select this option to both load
the specified PROFILE files and reevaluate suspended
PROFILE records.


• Load Unprocessed — Select this option to load all
Unprocessed PROFILE records in the PROFILE Staging
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table. This skips records with a status of "Error Encountered.
"


Add Action Select the action to be taken for rows that can be loaded.


• Add New Record Only — Add ONLY new PROFILE
records into the system; do not overwrite existing PROFILE
records.


• Overwrite Existing Record — Add new PROFILE records
into the system AND update existing PROFILE records.


Load HHB Files (load non custodial
parent data files)


Select Yes to load non custodial parent data files.


Run Option Select one of the following:


• Single: Load only a single XML file


• File List Driven: If you have multiple XML files to load,
 you can combine them into a single load instance by using
File List.


Create a .TXT file that includes a list of the multiple XML
files you want to load and their corresponding source path.
 The PROFILE Import process reads the .TXT file and
searches for the listed XML files using the path defined in
the file list. If an error is found for a file in the list file, the
PROFILE Import process loads the previous files into the
database and then stops processing. The files after the file
in error are not processed. Use the message log to view the
files that the system loaded successfully or unsuccessfully as
well as any corresponding error messages.


Note: The Process Monitor can display the run status as
Success even when a problem occurs with the load process.
 To determine whether all files in a file list were successfully
processed, open the date-stamped list file and verify that its
content does not reflect an error in processing.


Note: Each PROFILE XML file must have a unique file name. If you attempt to load a record with a
duplicate file name, the PROFILE load process fails.


Related Links
Page Used to Set Up PROFILE Data Load Parameters
Setting Up PROFILE Data Load Parameters
Overriding Expected Family Contribution (EFC)
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Viewing PROFILE Load Summaries
The PROFILE Load Summary component displays the load status and other details of each record of the
file selected to review from the PROFILE Staging Table.


Access the PROFILE Load Summary (Financial Aid > File Management > PROFILE Import > Load
Summary > Load Summary).


PROFILE Batch Detail Records tab
Image: PROFILE Load Summary page, Batch Detail Records tab


This example illustrates the fields and controls on the PROFILE Load Summary page, Batch Detail
Records tab. You can find definitions for the fields and controls later on this page.


CSS ID (College Scholarship Service
ID)


Displays the unique identifier assigned to student by the
PROFILE system.


Note: For the 2019–2020 Aid Year and forward, this field
displays the College Board Financial Aid ID value for
PROFILE.


Load Status Displays the Load Status of the record.


• Unprocessed — Record is loaded to PROFILE Staging table
but is not loaded to Inst App tables.


• Suspended — Record failed Search/Match or PROFILE Add
Level load rules.


• Processed — Record is loaded to application table.


• User Delete — PROFILE Application Record has been
deleted by the user.


• Discarded — Record is not loaded because it is a
Noncustodial PROFILE or Registration Only record.


• Skipped — Record meets Search/Match and PROFILE Add
Level load rules, but there is an existing record and the load
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parameter is "Add New Record Only" or the Review Status
is Complete on the Packaging Status Summary.


• Error Encountered — Scenarios in which status is
set include: Data Load Parameters not set, missing or
mismatched Aid Year, SSN invalid, SQL Error, and
invalid data in Search/Match fields. Status can be set by
user manually when an errant record is identified on the
PROFILE XML file.


Student's Admit Level Displays the student's admit level as associated with Academic
Program Statuses in the Defining Application Processing
Options, Working with Applications, Reviewing Admit Level
Associations page.


The values are:


• 5 - Accepted/Continuing


• 4 - Admitted


• 3 - Applied/Pending


• 2 - Inactive


• 1 - Has Not Applied


Application Type Displays the PROFILE Application Type


• Domestic PROFILE


• Canadian PROFILE


• International PROFILE


Student Record Type Displays the CSS Student Record Type


• Initial


• School Added


HouseHold Type Displays the type of PROFILE application received:


• HHA – custodial parent application received.


• HHB – non custodial parent application received.


Merged HHA/HHB Displays if custodial parent and non custodial parent PROFILE
applications have been loaded:


• Yes – Both the HHA (custodial parent) and HHB (non
custodial parent) PROFILE applications have been loaded.
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• No – Only one parent PROFILE application has been
loaded: HHA (custodial parent) or HHB (non custodial
parent) as indicated by the HouseHold Type field.


Update Status to Error Click this button to set the Load Status from Unprocessed
to Error Encountered. Records with a Load Status of Error
Encountered can be skipped during subsequent PROFILE Load
attempts.


Student Information tab
Image: PROFILE Load Summary page, Student Information tab


This example illustrates the fields and controls on the PROFILE Load Summary page, Student
Information tab. You can find definitions for the fields and controls later on this page.


National ID For United States students, displays the Social Security Number.
 For non-United States students, displays the student's country
and National Identifier or default National Identifier.


Dependency Status Displays Dependent or Independent


Financial Aid Status • New – Either a first-time applicant entering student or a
first-time applicant, continuing student


• Renewal — Continuing student
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Load Information tab
Image: PROFILE Load Summary page, Load Information tab


This example illustrates the fields and controls on the PROFILE Load Summary page, Load Information
tab. You can find definitions for the fields and controls later on this page.


Suspend Reason • FA Term Not Built– At least one FA Term record for the
corresponding Year does not exist.


• Manual– Load Status set to Suspended manually by the user.


• Non-Unique Student ID Found – More than one student
meets the Search/Match criteria.


• Packaging Completed– Student's Aid Processing Status is
Packaging Completed.


• Student ID not Found– No student met the specified Search/
Match Rules criteria.


• Student Not Admitted– Student met the Maximum Search/
Match Level but failed the Admit Level.


• Student not at Load Level – Student ID found, but student is
not at the designated Admit Level.


Skip Reason • Final Review Flag Set — Review Status is Complete


• Student Already Exists — PROFILE Load encountered a
matching ID despite the Add Action = Add New Record
Only; therefore, the student is suspended.


• Student Not at Suspend Level — Student fails Suspend
Level rule.


• Manual—- Load Status set to Skipped manually by the user


Alternate Institution Displays the Alternate Institution for PROFILE records
that were deleted by the user (status of User Delete) and
reloaded (status of Processed) to a different Institution than was
originally loaded.
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PROFILE Staging Table Data tab
This tab displays links to view PROFILE data as it is received from the College Board.


Image: PROFILE Load Summary page, PROFILE Staging Table Data


This example illustrates the fields and controls on the PROFILE Load Summary page.


Managing Suspended PROFILE Records
Access the Profile Suspense Management Records page (Financial Aid > File Management > PROFILE
Import > Suspense Management > Profile Suspense Management).


Image: PROFILE Suspense Management Records page


This example illustrates the fields and controls on the PROFILE Suspense Management Records page.
You can find definitions for the fields and controls later on this page.


Use the PROFILE Suspense Management Records page to review and manage unmatched, unprocessed,
and deleted PROFILE records.


CSS ID (College Scholarship Service
ID)


Displays the unique identifier assigned to student by the
PROFILE system.
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Note: For the 2019–2020 Aid Year and forward, this field
displays the College Board Financial Aid ID value for
PROFILE.


Alternate Institution Enter an Alternate Institution code to reload a user-deleted
PROFILE record into the Institutional (IM) Application tables
with a new Institution value. Displays only when the Load
Status is User Delete.


See Deleting PROFILE Records.


Load Status Displays the current status of the record. If the Load Status is
Skipped or Suspended, the field can be updated. If the status is
Discarded or User Delete, the field is view only.


Note: If you update the Load Status to Discarded, the Load
Status cannot be updated again.


Add Profile Select this radio button and click the Process button to load a
suspended PROFILE record into the application table.


Note: Selecting Add Profile supersedes any Profile Routing
Control setup. Add Profile always adds the student into the
Institutional Application tables. Even if the student fails Search/
Match, because the Add Profile option is selected, the student
is added into the Institutional Application tables with a new
system-generated ID.


Note: Please refer to the decision matrix after the attribute
descriptions for this page to see how the ID, ID Lock, Add
Profile, and Recycle attributes work together.


Recycle Select this radio button and click the Process button to have the
PROFILE records reconsidered by the PROFILE load process
using the Profile Routing Control setup.


Note: Selecting Recycle always calls Search/Match. If Search/
Match fails, then the "Search/Match No Match Action" defined
in the Profile Routing Control is interrogated to determine the
next step:
If "Allow Add if Eligible", a new ID is created if the student
meets the criteria for adding a new record.
If "Suspend", the student's record remains in the Suspense
Management table.


Note: Please refer to the decision matrix after the attribute
descriptions for this page to see how the ID, ID Lock, Add
Profile, and Recycle attributes work together.
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Process button After selecting the Add PROFILE or Recycle radio button, click
this button to invoke a real-time action to load the PROFILE
record into the Institutional Application (IM) tables.


Add Action Select the action to be taken for rows that can be loaded.


• Add New Record Only — Add ONLY new PROFILE
records into the system; do not overwrite existing PROFILE
records.


• Overwrite Existing Record — Add new PROFILE records
into the system AND update existing PROFILE records.


ID Select the ID to use to load the PROFILE record into the
application tables.


Note: Please refer to the decision matrix after the attribute
descriptions for this page to see how the ID, ID Lock, Add
Profile, and Recycle attributes work together.


ID Lock Select this check box after the selecting the ID to force the
PROFILE load process to use the ID as the matching person.


Note: Please refer to the decision matrix after the attribute
descriptions for this page to see how the ID, ID Lock, Add
Profile, and Recycle attributes work together.


Max Match Level Found Displays the highest Search Match Level rule that was met for
this PROFILE record.


General Information Click this link to display general information about the student.


FNAR Messages Click this link to display FNAR messages.


Search/Match Click this link to access the Person Search Match page and
search for a student ID to match to the PROFILE record.


The following table is a decision matrix explaining the results of different combinations of the ID, ID
Lock, Add, and Recycle attributes on this page.


ID ID Lock Add Recycle Treatment


blank unchecked selected not selected Call Search/Match.
Assign record new ID if
no match found. Record
added.


blank unchecked not selected selected Call Search/Match.
 Based on PROFILE
Routing Control
parameters, record
added or suspended. If
added, assign new ID if
no match found.
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ID ID Lock Add Recycle Treatment


blank checked selected not selected Search/Match not
called. Assign record
new ID, warning given.
 Record added.


blank checked not selected selected Search/Match not
called. Based on
PROFILE Routing
Control parameters,
 record added or
suspended. If added,
assign new ID, warning
given.


not blank unchecked selected not selected Warning given before
calling Search/Match.
 Record assigned new
ID if no match found.
 Record added.


not blank unchecked not selected selected Warning given before
calling Search/Match.
 Based on PROFILE
Routing Control
parameters, record
added or suspended. If
added, record assigned
new ID if no match
found.


not blank checked selected not selected Search/Match not
called. Record added
with specified ID.


not blank checked not selected selected Search/Match not
called. Based on
PROFILE Routing
Control parameters,
 record added or
suspended. If added,
 record assigned with
specified ID.


Reviewing Institutional Correction Audits


This section discusses how to view institutional correction audits.
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Page Used to Review Institutional Correction Audits
Page Name Definition Name Navigation Usage


Institutional Application
Correction Audits


INST_CORR_AUDITS Financial Aid > Institutional
Application Data > View
Correction Audits >
Institutional Application
Correction Audits


Review corrections made
to a student's institutional
application using the Maintain
Institutional Application
component. This page enables
you to track certain limited
changes that you make to
a student's institutional
application data.


PROFILE Application Delete SFA_PF_DELETE Access the PROFILE
Application Delete page 
(Financial Aid > File
Management > PROFILE
Import > Delete PROFILE
Records > PROFILE
Delete Utility > PROFILE
Application Delete).


Use this page to delete
PROFILE applications.


Viewing Institutional Correction Audits
Access the Institutional Application Correction Audits page (Financial Aid > Institutional Application
Data > View Correction Audits > Institutional Application Correction Audits).


The system displays the student's name, ID, Aid Year, and Institution.


The system displays the following information relating to a change made to a student's institutional
application (PROFILE, Institutional, or Canadian): User ID of the person who made the change, the Date/
Time of the change, the application Source for the Old Value, the record and field name of what changed,
the original data—Old, and the changed data—New.


Changes are listed in reverse chronological order, by Record Name, then Field Name.


Deleting PROFILE Records
There are rare cases when a PROFILE record is accidentally loaded either to another student or to the
wrong Institution. There can be also cases where you specified the wrong EmplID (or similar severe
error) while manually adding a PROFILE application to the Institutional Application tables. You can use
the PROFILE Application Delete process to delete these erroneously loaded records. Running this process
deletes all corresponding Institutional application tables for the selected student for the specified Aid Year
and Institution.


Access the PROFILE Application Delete page (Financial Aid > File Management > PROFILE Import >
Delete PROFILE Records > PROFILE Delete Utility > PROFILE Application Delete).
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Image: PROFILE Application Delete


This example illustrates the fields and controls on the PROFILE Application Delete page. You can find
definitions for the fields and controls later on this page.


Note: The CSS ID column displays the unique identifier assigned to the student by College Board for the
2018–2019 Aid Year and prior Aid Years. For the 2019–2020 Aid Years and forward, this field displays
the College Board Financial Aid ID value for PROFILE.


You may delete PROFILE records for multiple students within an Aid Year in a single run of this process.
This removes PROFILE records from the PROFILE Application Records table.


The corresponding staging table data is not deleted and is assigned a new Load Status of User Delete.


Using PROFILE Suspense Management, you can subsequently assign user-deleted PROFILE records
(those with a Load Status of User Delete) to:


• a different ID within the same Institution.


Note: If you assign a user-deleted PROFILE record to a different ID, be aware that the target ID's
CSS ID is updated with the CSS ID of the source PROFILE XML record, and the target ID is always
associated with that CSS ID moving forward. Also, the Update Biographic/Demographic data
attribute on the PROFILE Data Load Parameters setup impacts whether or not the target ID's bio/
demo data is updated in Campus Community.


• a different Institution.


When you assign a PROFILE record to a different Institution, you designate an Alternate Institution,
which is used as the key Institution when accessing the record in the Maintain Institutional
Application component.


Note: If you attempt to view or retrieve the original PROFILE record using the PROFILE Load
Summary search, you must specify the original Institution to which that PROFILE record was loaded.
However, the Load Summary > Load Information tab displays the (target) Alternate Institution.


Once a user-deleted PROFILE record is successfully processed (loaded into the Institutional Application
tables) for the corresponding Institution and Aid Year, that PROFILE record is no longer accessible using
PROFILE Suspense Management.


Related Links
Managing Suspended PROFILE Records
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